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IT’S OCTOBER 2011 AND 
TIME AGAIN FOR A NEW 
EDITION OF THE EYE. 
NUMBER 4 ALREADY.
THIS TIME WE HAVE:

- The new Hertz icon ‘Horatio’ was 
designed by one of our own members, 
an indepth story from his hand. 
- Furthermore an article on how to 
improve your SBS in PS.
- PXL ON TOUR a simple idea: send 
a t-shirt on a worldwide journey visit-
ing PXL members.
We follow its adventures.
- Cover: Red Wasp by MnMCarta.
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PXLEYES PIN-UP CALENDAR

104 Especially for the ladies (and other interested) we 
have a free male pin-up birthday calendar for you! To 
print and keep forever.

MAKING OF HORATIO

82
One of our own members, Spaceranger (Rein) was the 
creative artist behind the new Hertz Car Rental icon 
‘Horatio’. He makes us insiders on this succes story 
by telling us the process behind it.

Arca shows you and gives you hints and tips how to 
make a succesful SBS. To make a better impact in our 
PhotoShop contests.

Ingredients: a t-shirt, a contest to make a print for it, a 
printer to add the print on the shirt and a lot of mem-
bers to send it to all over the world.

As usual we have several chain interviews again, 
members interviewing members. This time you can 
read up on Kyricom, Nasirkhan and K5683.

In our previous edition we started to show you the 
person behind the PXLeyes member and we continue 
doing that in this edition.
Lamantine, Karol and IDt8r show you their, very dif-
ferent, stories.
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The Duel of Oranges 
Hayato

U are too late.. IDIOT.!!!
hereisanoop

Navi sapiens
langstrum
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The Parrosus
Robart523

Iron cow
langstrum

Chinese Dragon
alan78chan

Moon Rider
CorneliaMladenova
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Text example

PHOTOGRAPHY: 	BEST OF JULY 2011

8 9THE EYE magazine of www.pxleyes.com

After a hard days work... 
karaflazz

After his worm lunch
 Remsphoto

Still got the blues.
 karaflazz

http://www.pxleyes.com
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Wood Mill 
273Kelvin

St James Cathedral
bf2015

Green Lynx Spider
MnMCarta

Quiet Class!
273Kelvin

http://www.pxleyes.com


CHRIS: Please tell us something about yourself. 

MARK: Hi. Well, I’m Mark, a 53 years young man who 
lives among the hills and dairy farms of central New York, 
USA. I’ve lived all over the country, though. I was born 
and raised on an island off the west coast of Florida. From 
there, I moved to Texas (the LONGEST two years of my 
life), then to Colorado, then Wyoming, then Vermont. I 
loved all three of those places. 
But, you go where the jobs lead, and I ended up mov-
ing from Vermont to New York. Rural New York is fairly 
nice, but my wife and I may move back out west when we 
retire. 

CHAIN INTERVIEW: ORY - KYRICOM
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I have extremely limited travel 
outside my country. I went to 
Canada one afternoon with my 
grandparents (they lived in Mon-
tana), and then back one day 
when we visited Niagara Falls. 
I went to Juarez, Mexico one 
evening in college, and my fam-
ily and I spent a week in Cancun. 
But that’s about it for being an 
international man of mystery. My 
wife and I will be celebrating our 
25th anniversary this December, 
and hope to travel much more 
now that our two sons are becom-
ing adults.

CHRIS: How did you get 
into Photography? How 

long have you been doing it?

MARK: We didn’t have com-
puter games and videos when I 
was a kid, so I always used to 
love to look through National 
Geographic and National Wild-
life magazines when I wasn’t 
playing outside, and still love 
taking shots of the outdoors and 
animals. 

When I was 12 years old, I saved 
up and bought my first camera – 
a Kodak x-45. It was a big deal 
for me because there were lower 
models (x-15, x-25, and x-35) but 
I saved up from lawn mowing 
and my paper route. It used a 126 
film cartridge and had a knob you 

could turn which would automatically advance the film 
(until you had to wind it again). 
It also had an early form of auto-exposure where the cam-
era would run through exposures until it recognized that it 
had enough light. Pretty spiffy for a 12 year old. 

I’m sure I bothered everyone in sight for a long time, but 
my family humored me. In college I had a Minolta X-G1 
and kept taking shots. 

http://www.pxleyes.com
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I’ve basically always had the interest, but it’s 
been taking more of a role at the front in re-
cent years. I guess I’ve been doing it for about 
40 years now, but more seriously for about the 
last five or six.

CHRIS: How do you earn a living? 

MARK: I am lucky enough to be paid to be 
one of the people who warps the minds of our 
youth. I’ve taught at the university level for 

the last 25 years at 6 
different universities.

A lot of that was in 
pursuit of a tenure 
track position, which 
I finally found at the 
job I have now. I’ve 
been at my present 
position for a bit 
over 15 years, and 
am now chair of our 
Humanities Depart-
ment. I like it here 
very much as we are 
a very small school 
(about 3,000 stu-
dents) in the middle 
of a rural area, but 
we have students 
from all over. 

Our little school has 
the most diverse pop-
ulation of any in the 
64 campus New York 
university system, 
and that really makes 
things interesting. It 
keeps you on your 
toes to be interact-
ing with kids from 
the projects in the 
Bronx at the same 
time as kids right off 
the dairy farm. While 
the humanities deal 

with the areas of art and photography, they have little to do with my actual job. I mainly teach 
communication theory, argumentation, and public speaking. I do usually put a few shots in the 
annual faculty art show, though.

CHRIS: What equipment are you on?

MARK: I am the proud owner of a Pentax 
K-7, but drool over the new K-5. I doubt I’d 
be trading up anytime soon though, as the 
K-7 is great and we’re trying to get two kids 
through enough school to actually move out so 
spending that kind of money would be a pretty 
tough sell. 
I have my old Pentax ist DS as a backup as 
well. I also have a 35-80mm zoom, a cheap 
100-500mm zoom, and my baby, the DA* 

200mm prime. I also have an assortment of tri-
pods and monopods and lights and flashes etc. 

I probably use the K-7 200mm combination 
the most. I also use about a ten year old photo 
editing program but wish I could afford a nice, 
new Photoshop program. I would be willing to 
accept donations!

http://www.pxleyes.com


CHAIN INTERVIEW: ORY - KYRICOM

16 17THE EYE magazine of www.pxleyes.com

CHRIS:  In your opinion, is it the camera or the photographer 
that makes a good picture?

MARK: Definitely the photographer. If you give a great photographer an old 
or average camera, they can still get great shots. I think this is easily demon-
strated simply by looking back at shots from photographers from the past who 
didn’t have the technological advantages of today. I would give up every stitch 
of technology in two seconds if I could have 1/10th the talent of Ansel Adams 
or some others. I do believe it’s a reflexive relationship though. If those with 
the wonderful eye were given the advantages of today’s machines, we can 
only imagine the genius that would be exposed.

http://www.pxleyes.com


SBS’s are an important part 
in our PhotoShop contests. 
They show how an entry 
was made but also have an 
educational purpose.

This article shows you one 
way of making an SBS; how 
to make a good SBS which 
eventually can be turned 
into a tutorial.

Creating a good SBS is much easier with the use of a 
Screen Print program. I originally used the default “Print 
Screen” that comes with Windows but found it was 
time-consuming and difficult. 

After experimenting with a number of “Trial” programs 
I finally found a free program that simplified the pro-
cess - ScreenPrint32 (SP32). This tutorial is based on 
ScreenPrint32. You can download it from here or Goog-
le “ScreenPrint32” and download from a site of your 
choice.

Should you choose not to use SP32 then download a 
Screen Print/Capture program you like and skip to Part 
2 of the tutorial. 

PART 1: INSTALLING and SETTING UP 
ScreenPrint32
1. Install ScreenPrint32  
NOTE: When installing ScreenPrint32 (SP32) in Vista 
or Windows 7 you should set the compatibility to “Win-
dows XP Service Pack 3” and “Run this Program as an 
Administrator” you also have to do this to the .exe file 
before running the program. See end of tutorial -PART 5 
- for detailed direction on how to set compatibility.

GUIDE ON MAKING AN SBS. by Arca
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2. Open SP32 and set up how you want it to 
work 

a. Capture Area Selection Method (I use 
Prompt User and Pre-defined the most)
i. Full Desktop
ii. Active Window
iii. Prompt user for Capture Area
iv. Pre-defined

b. Turn off the Print option!

c. Tick “Save Captured Area to Disk” then 
set “Filename” for the Screen Prints you cre-
ate (I usually name it something like “Image-
Name_SBS”; that way I can search for it later 
if needed). 

d. Select the “File Format” for your Screen 
Prints (I use JPG). 
e. Set the “Folder” you want to save the Screen 
Prints to.  (I always have a work-in-progress 
(WIP) folder for every image I create, inside 

my WIP folder I have another folder for my 
SBS creation Captures - named SBS-image 
name). 
f. Set the counter to 0 (or whatever number 
you need to be at ;D)

3. If you have chosen “Capture a Pre-Defined 
Area” now is the time to set up what portion of 
the screen you want to Capture.

4. Open the image you are going to be work-
ing on in your graphics program - tutorial was 
done in CS5 
NOTE: For Pre-defined capture I always set 
the view to in Photoshop to “Fit on Screen” 
(Ctrl 0). This way I can come back to the same 
size/position on the monitor for my screen 
prints (even when I have been zooming in and 
out). Having all your screen prints the same 
size is very useful if you want to create an 
animated GIF. 

5. Open SP32 (it should be in the SysTray). 
Double click on symbol 

http://www.esnips.com/doc/217e1050-1140-41f2-b2f1-876f409ea8db/sprint32 
http://www.pxleyes.com
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6. Select the Capture a Pre-Defined Area radio 
button and Click on the “Define Area” 

7. Follow SP32 direction for selecting area to 
copy 

8. Double check your Print and Save options 
in SP32 and make sure you reset the number-
ing to “0” (See 2-b to 2-f)
You are now ready for PART 2

PART 2: CAPTURING YOUR 
WORK-IN-PROGRESS (WIP)
1. As you work on your creation periodically 
zoom to “Fit on Screen” (Ctrl 0) and take a 
Screen Print by hitting the Print Screen button 
on your keyboard. This will Capture the image 
as you see it on the monitor. The more often 
you do this the more options you will have for 
the SBS creation (and for animated GIFs).

2. Periodically I reset SP32 to “Prompt User 
for Capture Area” and will Capture my pal-

ettes, layers or a close-up/detail capture of 
something small (E.G. Hair creation/detail).
NOTE: I always keep a copy of my complete 
layered image. It can take up a lot of hard dive 
space but it is worth it. This way you can al-
ways go back and get a screen shot if you have 
missed something. If you do not do this then I 
suggest taking a lot of screen shots!

3. Once you have completed your image and 
have all your Screen Captures you can begin 
to create the SBS. 

PART 3: CREATING THE SBS
1. Open the folder you captured your images 
to. Select the images you want to use for the 
SBS. (I use Bridge for this part)
2. Move the selected images into a new folder. 
In Adobe Bridge you can Batch rename and/or 
number them (I don’t usually bother unless I 
want to change the order they are in).

How to Batch Rename in Adobe Bridge
i. Make sure the images are in the order you 
want them in your SBS. 
ii. Select all images to be renamed/numbered 
(Ctrl A)
iii. Place cursor on an image and right click to 
get drop down box
iv. Click on Batch Rename
v. Assign criteria for Renaming/numbering

You should end up with something like this 
(Sample shows 9 of 14 SBS images I selected)

3. Open the 1st captured image in your Graph-
ic Program (in Sample h it would be “en-
hanced_01”)
4. Double click in the center of this Layer in 
the Layers Palette to “Unlock” it. (You can 
rename it but as Photoshop numbers the lay-
ers consecutively I leave them at their default 
name.) 

 

5.  Resize image to - Width = 500 pixels 
(Edit>Image Size or  Alt+Ctrl+i)

http://www.pxleyes.com
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6. Enlarge the Canvas Height size 
(Image>Canvas Size) to 12000 Pixels and An-
chor it at the top

7. Set View to “Fit on Screen” (View>Fit on 
Screen or Ctrl 0). (This ensures that when you 
drag in the rest of the SBS images they will be 
“Placed” correctly - see Step 8.)

8. Select the rest of your chosen Screen Print-
ed images you want to use (re: Step 2). 

9. Drag them into PS to Place them into the 
enlarged canvas. 
NOTE: (Photoshop CS2 and greater) Images 
will come into PS as Smart Objects. Even 
though you have dragged all images at the 
same time you will only see one image until 
you hit enter for each image; this “Places” 
the image into your canvas. Each time you 

hit enter the next image in the group will be 
“Placed” but they will be one on top of the 
other

Each image will look like Sample n before 
you hit Enter. They will all come into PS at the 
same place on the canvas. In the very middle.
I usually Rasterize the images once they 
are all moved to where I want them 
(Layer>Rasterize>Smart Object or dbl click 
in the center of the Smart Object in the Layers 
Palette.) 

10. Once you have all the SBS images in PS 
it is best to reverse the order of the Layers. In 
Photoshop CS and greater you can select all 
layers then go to Layers>Arrange>Reverse. 
Otherwise it has to be done manually.

11. Now you can move the PLACED (or 
PASTED) images into alignment.

12. Moving the layers into alignment:
a. Select all the layers (in the layers palette 
highlight the first of the newly imported 
layers>hold down the Shift key>go to the final 
image you want to select>click on that layer 
while still holding down the Shift key). 

                       
b. Move the whole group up to just below 
the first image (hold the Shift key down 
while moving them so they stay in line).
c. Hold the Ctrl key down and click on the 
second to top layer (this de-selects it). You 
will now have all layers selected except 
the two you don’t want moved (Layer 0 
& enhanced_02 - Sample p-3). Move the 
whole group down to just below the 2nd 
image. Continue in this manner until you 
have all images in a Vertical row as shown 
in long image Sample p-5

http://www.pxleyes.com
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PART 3: ADDING THE TEXT
1. Make sure the top layer is selected in the 
Layers Palette Zoom into the top of the SBS 
(Sample q)

2. Select the Text tool from the Tools palette 
(shortcut = t)

3. With the Text tool active left click -hold & 
drag to create Text Box into space you want. I 
use guides to get the correct position (Sample 
r). 

Type in a description of what you have done in 
regards to the layer you are describing (Sam-
ple s) 

4. You may need to move the image layers 
around to fit all your text in and you can even 
have the text description floating over the 
Screen print it relates to. (If moving all the 
layers down then use the same method shown 
in Part 2 - Step 10.)

5. From here is it just a matter of creating 
Text Boxes and typing in what you did at each 
stage. If you have trouble remembering what 
you did go back to the Original layered image 
for reference. 
NOTE: For Photoshop CS and higher a His-
tory of your work can be stored as text or 
Metadata (history is embedded in your image). 
See end of this tutorial (PART 6) for how to do 
this.

PART 4: WORKING WITH A 
REALLY LARGE SBS 
If you have an extensive SBS you can put a 
number related layers and their text descrip-
tions together in Groups (Folders) in Photo-
shop. 
How to Group your Screen Print images and 
Text into a Folder in Photoshop
1. Select the all layers you want to include in a 
Group - hold down the Alt Key and drag these 
layers to the Folder Icon at the bottom of the 
Layers Palette (Sample t-1). 
2. Name the Groups with a number for the 
Step it will be when uploading it (I also in-

clude a descriptive name - E.G. 01 Cut and 
create sky - this will be the first upload). You 
can also drag individual layers into a folder 
(either a newly created one or an existing one).

3. Once you have all the layers Grouped into 
Folders you can Hide all but the one you Save 
as a JPG. 
4. I name my JPG’s the same as the Group I 
am saving (this help when uploading to keep 
your uploads in order).  Like this:
a. File>Save for Web>Name: 01 Cut and cre-
ate sky (see image U below). 

http://www.pxleyes.com
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NOTE: You will not need as long a canvas 
with this method but you will have to crop the 
shorter Groups before Saving for Web. RE-
MEMBER to Ctrl Z (undo) the Crop before 
continuing. For Sample u-1&2 above I would:
i. Crop 04 Lighting and shadows (Sample u-2) 
before saving
ii. Save for Web (Ctrl+Alt+Shift+S)
iii. Undo (Ctrl Z)
iv. You are now back to the original size of the 
Canvas and have not lost any of 01 Cut and 
Create sky (Sample u-1)
By undoing your crop it will save you from los-
ing parts of other groups. 
When you save your complete layered SBS (as 
a TIF or PSD) all Layers will be intact and 
you will not have cropped longer Groupings. 
(I have done this and it is a drag ... you have 
to rebuild the part you have cropped out if you 
ever want to do anything with the SBS (like 
enhancing for a Tutorial).

Finally ... if you want to view a completed 
LARGE SBS you can see one I created here.

This is what it looked like in Photoshop - All 
Layers are in Grouped Folders. The 2nd Folder 
-2 Space is the only one visible (note the “eye” 
is not showing on the other Folders). 2 Space 
Folder is open and all the layers within that 
Group’s folder are visible (the “eye” is show-
ing). This tutorial had a more elaborate lay out 
as well!

PART 5 - Setting Compatibility for 
SP32 in Windows7 or Vista
For installing the program you do basically the 
same thing as shown here. These instructions 
are for the .exe file before you run Screen-
Print32 for the first time! 
1. Go to the location you installed Screen-
Print32 in (usually C:/Program Files/Screen-
Print32 v3 or for 64Bit C:/Program Files (86)/
ScreenPrint32 v3
2. Open the ScreenPrint32 v3 folder and find 
the .exe file. It should look Sample 5 

3. Right click on the .exe file and select Prop-
erties (Sample 5-A)

4. Select Compatibility tab in the Properties 
dialogue box

5. Click on Change settings for all users and 
tick the boxes as shown in Sample 5-C
a. Compatibility Mode - Windows XP (Service 
Pack 3)
b. Privilege Level - Run this program as an 
administrator

6. Click OK
You can now open ScreenPrint32 and it will 
run fine in Windows7 or Vista. 
SP32 will sit in your Systray and start up with 
Windows. If you do not want it to start until 
you are ready for it you can untick the box on 
the General Tab (in SP32) that says “Load at 
Startup”. 
WARNING: If you do this it will return to its 
default settings every time you open it.

http://www.pxleyes.com
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NOTE: For Duel monitors - ScreenPrint32 will 
only take a screen capture from your main moni-
tor!

PART 6 - How to Keep a History of 
your work in Photoshop CS and higher
a. 1The History log is disabled by default. 
b. To turn History on - go to Edit > Preferences 
> General (Sample 6-A)
c. In the lower section of the dialog box, check 
“History Log” box (Sample 6-A)

History data can be viewed in the metadata 
panel of Bridge, or from the File Info dialog 
(File>File Info>Scroll to History tab). Be care-
ful storing the history log in the metadata--it 
can increase the files size and reveal editing 
details that you’d prefer to remain undisclosed. 
I usually choose Metadata and Detailed.
Here is a short example of what a Concise his-
tory looks like

2011-09-18T05:36:25-07:00	
File Untitled-1 opened                                      
Smudge Tool
Smudge Tool
Brush Tool
New Layer
Brush Tool
New Layer
Smudge Tool
Smudge Tool
Brush Tool
Brush Tool
Brush Tool
Brush Tool
Smudge Tool
Smudge Tool
Gaussian Blur
Layer Via Copy
Layer Via Copy
Layer Via Copy
Make Layer
Layer Via Copy
Layer Order
Type Tool
Layer Order
Free Transform
2011-09-18T05:38:49-07:00	
File C:\Users\Me\Documents\Tutorial\His-
tory test2.psd saved

NOTE: The History can be quite confusing but 
you do get a time stamp when you Save so if 
you Save often you can compare the “Saved” 
time stamps to the time stamps on the Screen 
Prints; it will help you determine what you did 
within a certain period of time.
WARNING: When saving your History as 
text, if you work on a different file while re-
cording your History the info from that image 
will be included in the same History (unless 
you change it in your Preferences) this can be 
very confusing the solution is to save the His-
tory as Metadata. 

With the Metadata system each image contains 
only what was done to that particular image. I 
save my History as Metadata only and usually 
on Concise. 

Detailed is good but contains a HUGE amount 
of information; the same work done on the 
image used for Sample 6-B but using Detailed 
History created 5 pages of information!
	
That’s it! Enjoy!

Links in this article:
Download ScreenPrint32 here
Example of a large, complete SBS here

Written by: Arca.

d. You can choose whether you want the information embedded into the file as metadata, stored 
in a text file, or both. If you pick the text file option, you will need to click “Choose...” and tell 
Photoshop the name and location of the file where you want the data saved.
e. Under “Edit Log Items” you have three choices: 
i. Sessions Only - only records when Photoshop is opened and closed and when each file is 
opened and closed. Useful for time tracking. 
ii. Concise - records Sessions information, plus the text that appears in the history palette. 
iii. Detailed - records all of the above, plus the text that appears in the actions palette. This es-
sentially tracks the complete history of editing for the file.

http://www.pxleyes.com
http://www.esnips.com/doc/217e1050-1140-41f2-b2f1-876f409ea8db/sprint32
http://www.pxleyes.com/guide/43298/the-making-of-Interstellar-Overdrive.html


Hi everyone, I’m Karol. I’m from the Philippines. 
I live in a town called Tayabas, 

a 4-hour drive from the capital city, Manila.
 

It is located at the south-eastern foothills of one 
famous volcano (though dormant) in the 

country, Mount Banahaw. 
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Our town is best known for coconut vodka, 
spring resorts and historical places. Our town 
is blessed with fertile land for rice fields and 
coconut plantations. Sadly, some portions of it 
were already converted into residential areas, 
subdivisions mainly. We’ve been here for 10 
years now. My family wasn’t native to this 
town. We moved a lot when I was little, rea-
son being the nature of my parents’ jobs. Back 
when my brother and I just started college, the 
town is the most perfect choice to live as the 
university is just in the next town, one jeep-
ney-ride away.  
	

I married my college classmate, and have been 
married for four years now. We had our second 
child last year. I spend most of my time tend-
ing my kids at the moment; as my husband’s 
work is in the city. I do photo-book layouts in 
my part time; getting paid for it a bit and take 
photos of random things whenever I can. 

Two years ago, I was still unsure what I really 
wanted to do with my life, and that is when I 
discovered photography and fell in love with 
it. Irony has it, my husband was the one who 
stumbled upon pxlshots and there it began.
 
Growing up with simple life with a strict fa-
ther, it’s not been easy for me and my siblings 
to get and do whatever we wanted or try.  The 
most important thing our parents taught us is 
how to prioritize things and if we want some-
thing, we have to work hard for it. So I’ve got 
these big dreams, and I promised my mother to 
finish my studies. I am aware how she sac-
rificed so many things for her children; one 
thing being how she wanted to stay home and 
be with us. (Both of our parents were working 
full-time as government employees in towns 
a bit far from our residence, so we only see 
each other during weekends and we only got a 
nanny with us every day. Then eventually we 
learned to deal with things on our own.)  

I was really excited to graduate from college, 
then get a job and live the dream of total in-
dependence. I wanted so many things and I 
already had set my timeline.
Things didn’t turn out the way I pictured it to 
be. I got pregnant. No one in my family ex-
pected it, not even me. They knew that I had a 
boyfriend and we were together for three years 
then but they were not ready for it either as 
they knew that I’d be graduating soon. 

VISIT KAROL AT www.pxleyes.com/profile/karol/
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I was disappointed with myself more than 
anyone else; I couldn’t believe myself that I 
let it happen. Most people at this age and point 
in time, being fresh graduates, were already 
starting to explore the world, having the time 
of their lives, enjoying their careers; but here I 
am, dealing with a mind-numbing task of be-
ing a mom.  
It took me a while to accept my situation. It 
helped greatly that my boyfriend took the re-
sponsibility of me and our baby. 

That brings me to married life. I gave birth the 
next day after our graduation ceremony.  When 
I first laid my eyes on my daughter, she was 
the most beautiful thing I’ve ever seen. All re-
grets vanished; I found peace and contentment 
just looking at my little girl.

So now I have two beautiful children, the sec-
ond being a cute baby boy. We are not thinking 
about having another one as it’s just financially 
impossible to make both ends meet. I had two 
jobs before; my first was being a cashier at a 
department store, as there aren’t much job op-
portunities nearby. 

I worked six-days in a week, including holi-
days; but at least I got to see my baby every 
day. One thing I can’t stand about it is the 
other customers’ treatment to us cashiers. It 
had me greatly disagree with “customer is 
always right” philosophy, as most people just 
look down on that job, though you have to be 
at least four years college graduate to be able 
to work as one. I tried my very best to ignore 
rude customers and stretched my patience until 
the end of the contract. 

Then I worked in a Municipal Budget Office 
but it’s impossible to get a permanent posi-
tion there, though I learned so many things 
and gained friends. I also quit that job later on 
because I don’t want to be stuck there and do 
things that I don’t want to do.  

Aside from photography, painting is 
another passion of mine. I paint 
whenever I got spare time.

Basilica of St. Michael the Archangel,our 
church. One of the oldest and  most beautiful 
churches in our country.  I want to shoot wed-
dings here someday.

Jeepney;
a common mode of public transportation.
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The thing I looked forward to the most is to 
pursue photography as a profession. I want to 
be a portrait and wedding photographer, I’ve 
always been an introvert and it will be a great 
challenge for me interacting with different 
people, capturing emotions and to reveal the 
subjects’ character.  

Last March I was given a great opportunity to 
publish some of my photos in one of the major 
publications in our country. It was an article 
about this website for stock photos from ama-
teur, freelance and professional photographers 
in the country and they chose three of my pho-
tos and had a short interview. It was a thrilling 
and also a humbling experience.

HOME STORY: KAROL
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When I started photography two years ago, 
I was only using a point and shoot camera 
so there’s a dream camera on top of my list I 
should get. 

My mother saw how serious I am about pho-
tography and she was about to get me a decent 
camera when a family friend, who’s also a 
photographer, gave me more decent one few 
months ago. A DSLR that he bought three 
years ago. He just got a new camera and de-
cided to give the old one to me in exchange of 
the photo-book layouts.  

I am very grateful for it as I don’t 
have to borrow money from my 
mom.  I am planning to have a 
small home studio but equip-
ments cost a lot of money so I 
guess I have to wait a little long-
er. 
I will probably attend some 
workshops in the next few 
months as there is so much to 
learn. I am currently working on 
my portfolio and these past few 
weeks I am able to shoot por-
traits. Some of my friends are 
now even more willing to pose as 
models for me and also I got few 
clients.  

It stresses me out sometimes, 
thinking about lots of ideas and 
deciding but it feels very ful-
filling if I get it done. With the 
support of my family I feel like 

I’m half-way through it. Now I 
am not alone, my kids inspire me 
to chase my dream, they give me 
strength to do so much more. 

Thank you for reading and being 
part of my journey.

One of the few remaining colonial stone 
bridges in our country. Built in 1850 and 
considered to be one of the most important 
heritage sites in our town.

Alabat Island,my parents’ 
hometown. We visit there at least 
once or twice a year.

Taytay falls,located at the nearby town.
The clear and icy water flows from 

Mt. Banahaw.
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Wet Senses
karaflazz

Just cause Adam said it...
karaflazz

for rent - created by dekwid.
karaflazz
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From darkness to light
EmiK

Rhythm Of The Night 
locksmagic

The “Thinker”
itsmymoment

Cheetah 
itsmymoment
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Vigil 
 IDt8r

Battle Seahorse
Robart523

Creature of Evolution 
Robart523
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kidnapper x
kushpatel

The First Weaver
IDt8r

The Sacred Golden Warrior 
Hayato

Where Little Birds Live
 George55
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That’s exactly what we are plan-
ning to do: send a t-shirt on a 
worldwide journey visiting as 
many possible countries and con-
tinents and meet as many pxleyes 
members as possible within 1 year.

Every participant is asked to sign 
the t-shirt, make some photos and 
send the shirt to the next person. A 
small diary acompanies the t-shirt 
in which participants can write 
down what happened to the t-shirt.
The photos will be send to and 
published in this magazine, every 
edition for the coming year this 
magazine will pay attention to it.

When the year is finished the 
t-shirt is returned to the starting-
place. 
All participants must make a guess 
at the total travelling distance, the 
one closest to the end distance will 
win the t-shirt.
 
During this year the t-shirt will 
travel a random journey around 
the world, new destinations will 
be assigned only after it arrives at 
a new member. Those destinations 
will also be randomly picked. 
Participants do not know when the 
postman will ring during that year 
and delivers a package.

The content of the diary will be a 
secret and will be fully printed in 
the EYE after the journey is fin-
ished.

PXL ON TOUR
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THE PREPARATION:

- ORGANIZING THE CONTEST
We explained our admin what we were planning and 
asked if he could run a design contest for the t-shirt.
The question became a contest and the contest got  a win-
ning entry.

The ingredients are simply: 
buy a t-shirt, organize a contest to design it’s print, have it 

printed with the winning entry and send this around the world. 
Follow its adventures through this magazine.

- BUYING A T-SHIRT
Not a such a difficult task: find a random clothingstore 
and buy a white t-shirt European size XL.

http://www.pxleyes.com
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- HAVE THE T-SHIRT PRINTED
Go to a local printshop and have it print-

ing the winning design to the t-shirt.

- ALL PACKED UP AND READY TO GO:
It’s Saturday October 1, 2011: time to start the 
worldwide journey! Somewhere early October 
2012 we expect this package back.

We stacked everything in  a nice big box, picked the first destina-
tion and send it of into the world! See you back in a year!

http://www.pxleyes.com


MARK: Please tell us all a little about yourself. 
How old are you and where are you from? What 

do you do besides chopping? Do you have any 
unusual hobbies or anything?

NASIR: I am 45 years old from Pakistan. Profession-
ally I am Accountant. As a part time programmer, I have 
developed some custom made database software for 
small business. I am hobbyist musician and keyboardist 
and have uploaded some compositions for online sale. I 
presently create vectors, illustrations and 3d renders for 
various stock agencies.

CHAIN INTERVIEW: KYRICOM - NASIRKHAN
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MARK: I’m certainly 
no expert in Photo-
shopping, but when 
I look through your 

portfolio it seems very 
impressive. What pro-
grams, equipment, or 
magic wands do you 
use? How long have 
you been chopping?

NASIR: I used photo-
shop for all my chopping 
works and my favorite 
tool is ‘wrap’. It takes 
some time to master but 
it’s very useful for creat-
ing all sorts of shapes. I 
also use adjustment lay-
ers for creating mood and 
matching color/tone. 

MARK: Are you employed in any type 
of artistic industry, and if so, do you 

find your work here helps you? Or, do 
you just chop for fun?

NASIR: No. I am employed as an accountant 
and do chopping just for fun and enjoyment.

MARK: Your portfolio seems fairly ec-
lectic. Do you have a favorite “style” or 

type of subject that you like the most?

NASIR: I try my best to not be limited to 
any particular style. I try different styles. I 
have observed some other artist’s works and 
use these new learned techniques in my own 
work. I am still not satisfied with my work and 
am eager to learn more, but face a shortage of 
time. 

VISIT NASIRKHAN AT www.pxleyes.com/profile/nasirkhan
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MARK: Do you remember the very first 
chop you ever did? What was it, and 
were you satisfied with how it turned 
out? Did you teach yourself most of 
what you know, or did you learn in 

some other way? How did your talent 
reach the level it’s at today?

NASIR: I started photoshop in 2002 and my 
first photo manipulation was just a collage of 
some images with a background of default PS 
pattern. I am a self trained person. I learned 
computer programming (Visual Basic and 
Visual FoxPro), photoshop, 3ds max, music 
notation, illustrator etc with the help of trial 
& error, tutorials and video training. This is a 
non-stop process and I am still learning. “Cop-
ying style” is another great way for my learn-
ing adventure. It’s not easy to create your own 
work in another artist’s style without the help 
of any tips, tutorial etc. 

MARK: Comparing that first chop to 
what you’re doing today, what is the 

most important or useful thing you’ve 
learned about technique? Did you teach 
it to yourself, or did you pick it up from 

someone?

NASIR: In the early learning stages, I ob-
served that many great artists were using wrap 
and liquify tools for their amazing work. So I 
practiced with the wrap tool to get some con-
trol on it, which really helped me for creating 
some great entries. Another great technique is 
alt+ctrl+shift+t (shortcut of “transform again” 
command).

VISIT NASIRKHAN AT www.pxleyes.com/profile/nasirkhan
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MARK: When you look at the new 
contests each week, do you find yourself 
drawn to source or theme contests? Do 
you have a definite idea when you start 

an entry, or does it kind of evolve as 
you go?

NASIR: I usually try to chop the harder 
source themes and take it as challenge. I 
choose theme contests if it attracts me or has 
something new to experiment on. Sometimes I 
have a definite idea to work toward, but some-
times I just start cutting pieces from the source 
and assemble them differently until I see some 
character or object to start working on. 

MARK: I notice in the rankings that 
you’re ranked second, only 100 tiny 

points behind Drivenslush. Is he your 
arch-nemesis? Should we all chip in 

and rent a steel cage and throw you 
both in? Seriously though, is there any-

one on the site you have learned a lot 
from? Is the site a source for friends, 

learning, teaching? How does Pxleyes 
fit into your life?

NASIR: Drivenslush is not my arch-nemesis. 
I was on top from the very first week of the 
newly created pxleyes. I maintain my 1st top 
position for approximately 2 years. Recently, 
I came to the 2nd position because I am not 
regularly participating in contests for the last 
1 year. The reason is that now I am creating 
vector illustrations and 3d renders for vari-
ous stock agencies for online stock sale and I 
am happy with my progress, both in learning 
and earnings. My aim is to increase my online 
portfolio size to at least 1500 images, which is 
currently 750 images. 

MARK: If aliens came 
down and destroyed all 
computers and artistic 

supplies, what other 
activities would you do 

to fill your time and 
mind?

NASIR: I would draw on 
the wall and ground using 
coal or chalk, sculpt, ori-
gami using leaves, play the 
flute, etc. 

MARK: What advice 
would you give some-
one who is just start-
ing to learn to chop? 

Are there any resources (besides our 
wonderful site) that you would recom-

mend?

NASIR: Learn the fundamental and basic us-
age of tools and menu commands along with 
their keyboard shortcuts. Advanced and power 
users always use keyboard shortcuts to speed 
up their work. Learn how to use the pen tool. 
It’s a very powerful tool. My last advice is 
to practice, practice and practice. Remember 
practice makes a man perfect. Pxleyes has very 
nice collection of exclusive and non-exclusive 
tutorials. Beside this, Youtube is another great 
source for video tutorials. I also recommend 
psd.tutsplus.com. The internet is full of re-
sources, just Google for “photoshop beginner 
tutorial” 

Thanks for the opportunity to be interviewed 
for eye magazine.
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Im Aqiil Gopee, also known as Lamantine, and im 14 
(I was born on the 22nd of June 1997) 

and member of PXLEyes since 22nd of December 2009. 

I live in Mauritius, a small island in the Indian Ocean,
 next to Madagascar. 

The island is in fact populated by many dif-
ferent races and religions, including indians, 
asians, africans, and caucasians. Our religions 
include muslims (mine), hindous, christians, 
catholics, jews, and many more. 

Yeah they say that its kinda peaceful and all to 
live on an island and that its like « paradise » 
but without wanting to sound un-patriotic, I re-
ally would like to live somewhere else. 
Mauritius is a nice place, considering peace 
and isolation but the population just does not 
want to work enough so as to raise the sta-
tus of the island, and many important human 
qualities are very often ignored, such as art, 
music or literacy. 

Most of the people just want to go to school 
till secondary level, find a job, get married, 
found a family and die in peace. Im not cricti-
cising anyone but really ; is that life’s purpose? 

Maybe I’m young, but no one’s too young to 
have ambitions. And im extremely ambitious. 
I just can’t wait to finish my secondary educa-
tion and get to university, in America. 

Im currently studying at the 
Royal College Curepipe, the old-
est and most prestigious all-boys 
school of the island, built by the 
French and took over by the Brit-
ish when they conquered island 
(before we got our independance) 
. 

And let me tell you, our educa-
tion system here is really differ-
ent from the others. After pre-pri-
mary, we go to a primary school 
where we study for 6 years, at 
the end of which there’s an exam 
called the C.P.E (Certificate of 
Primary Education) Examinations 
which will determine our apti-
tudes and split us all over the sec-
ondary institutions of the island 
according to our grades. 

Then we have to endure another 7 years in that 
secondary school, until we – finally ! – will 
have to look for a University. 

Im in grade 9 (my 3rd year of secondary) and 
there’s still 4 years to go (although there’s still 
a possibility that I go for my tertiaries before 
that if I do my very best in my exams). This 
year we had to choose the subjects we were 
going to do for grade 10, and I chose English 
Literature, Literature In French, Sociology and 
Visual Arts – Mathematics, Additional Math-
ematics, English and French being compulsory 
subjects. 

http://www.pxleyes.com
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As you can see, I’ve got a passion for the Arts 
since young, although most of the members of 
my family do not quite approve my choices. 

But I don’t care, I have a life and I want to be 
the one who controls it. Im aiming to get a de-
gree in Psychology at University and work as 
a counselling or experiemental psychologist, 
and do some research in the subject. 

Human psychology really fascinates me; I 
always look at people when im out or even at 
home (I have 3 little brothers, Anas, 10, Ayaaz 
6 and Assim, 2) and Im always trying to figure 

out what they’re thinking or what would be 
their reaction to certain occurrences. 

My favorite activity is to concentrate about 
someone anonymous whose just walking by 
and try to guess when this particular person 
has ever felt sad, angry or happy. I mean, when 
they walk on the streets or relax on a bench, 
most of them are so neutral, and imagining the 
emotions on their faces really fascinates me. 
If you think that makes me strange, then 
you’re not the only one cause most of the peo-
ple who know me think that way. 
My parents even brought me to a psycholo-
gist ! But of course, that was a wonderful 
experience and I don’t consider that as being 
something shameful. Actually, that solidified 
my will to adopt this as a job later on. 

So, back to my passion for the arts. I discov-
ered Photoshop in 2008, when I was 11, along 
with PXLEyes (or more precisely, photoshop 
talent). I was just overusing filters at first, and 
rarely participated in the contests, and eventu-
ally I abandoned it. 

But I downloaded Photoshop two years later, 
in 2010, and that’s when I really started using 
it. I did tutorials on the internet, and learned 
the basics and all all by myself and with the 
help of the PXL members (especially jawshoe-
whah and jellopudding who are now sadly 
gone, and also from CMYK46 although I just 
couldn’t understand he was trying to help me 
at first). 

I eventually got better and I also started Pho-
tography. I was absolutely lame when I started, 
(bringing me cynical comments from friiskiwi 
and some other members :P ) but I got better 
too eventually, shifting from my mobile phone 
to a compact Sony, then to a Canon Ixus 105, 
then finally to my first SLR, a Canon EOS 
1100D. 

Im still improving, learning from all my mis-
takes and from the advice the members who 
are now my very good friends, and i’ve even 
won a couple of contests. 
Traditional drawing is a hobby of mine too, al-
though I never seem to do well in the contests 
due to poor quality of the entries, and although 
I’ve tried digital drawing more than once, I 
just can’t do it. And 3D is really not my thing, 
but I apprectiate those who take their time to 
do those breathtaking 3 dimensional works we 
have in PXLEyes.

 I also have a thing for Literature and Writ-
ing, and Im proudly announcing that I finished 
the writing of my first novel on Monday 08th 
August. It is entitled « La Pièce » (in english I 
would call it The Attic). I submitted it to a con-
test, and if I win, my novel will get published. 
Unfortunately, it is in French and most of you 
might not be able to read it but let me give you 
a brief summary of it.

My little brother, Assim.

My School...at night.
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Its the story of a teenager called Thomas Blake, 
who, along with his parents move to a new 
house which is found just under a hill called 
Brynmor Hill. While exploring the house, Tom 
discovers a mirror in one of the bathrooms and 
is strangely attracted to it and when he tries to 

One day, when he was coming back from 
school, instead of heading to Brynmor Hill 
like he usually did, he went straight to the at-
tic, feeling a weird attraction towards it. When 
he reaches there, the door closes all by itself 
behind him, and a cold wind blows all over the 

den change, and the Attic finally talks to him, 
revealing that he is an Illusion that lives and 
that Thomas needed to choose between Light 
and Darkness; if he chooses Light, the entity 
which lives in the Attic will scare him and his 
family until they mutually kill each other out 

of madness, but if he chooses Darkness, he 
will benefit from the protection and presents 
of The Attic. After much hesitation, Tom finally 
chooses Darkness. The Attic is very happy of 
his decision and offers him a black necklace 

as a gift. It tells him to use it, and when he 
does, he gets transferred to another dimension 
called the Dreamland, where all the dreams 
and thoughts of human beings go. 

Thomas is delighted to see his own dreams just 
touch it,  he feels a weird tickling 
sensation along his arm. 
He freaks out and leaves, and goes 
to visit the other parts of the house, 
where he discovers the dark attic, 
which is too dark to be properly ex-
plored. 

Then we are introduced to the 
dreamy personality of Thomas, 
who loves to think and dream, even 
writng his dreams in his journal 
everyday. As the days go by, every-
thing goes on smoothly, and he had 
even developped an affection for 
Brynmor Hill, which he climbed up 
everyday so as to dream in the mid-
dle of the winds and the flowers. 

But one day, Tom’s parents get into 
an unexpected and violent fight, in-
citing the troubled boy to go and 
hide in the dark attic. There he 
falls asleep and has a nightmare, 
about his mom trying to kill him, 
and promptly wakes up, realising 
he was still in the attic and asking 
himself how comes that he had a 
nightmare because he’ve never had 
them before. 
And the next day, his parents 
seemed to be loving and caring again, much 
to Tom’s surprise. He thinks that the fight be-
tween his parents was just another nightmare, 
and he forgets about it. But things eventually 
start to change. 

place. 
The attic is no longer the same ; there are in-
sects all over the place, the wooden floor is 
rotten,  and there is a black fog moving all 
over the room. Tom is intrigued by this sud-

in front of him. The Attic tells him 
that he’s also able to visit other 
people’s dreams if he summons 
The Door. He does, and finds him-
self at the center of the Dream-
land, ressembling a huge corridor 
with countless mirrors of different 
shapes on the walls. 
He chooses one at random, and he 
discovers a fairy with a little girl 
in the dream. But the fairy sees 
him too, and as he is now a servant 
of Darkness, the fairy, who is serv-
ant of Light, tries to kill him with 
stones coming from the clouds. 
Thomas is injured and bloodshed, 
but manages to get out and go 
back to the Attic, where he begs it 
to heal his wounds. But the Attic 
does not respond, and instead yells 
at him to get out of there. Thomas 
is too weak to move, and he feels 
like someone is drinking his blood 
just before he falls unconscious.  

When he wakes up, he’s in his 
room where a doctor is examining 
him in the presence of his parents.  
Before they go, Tom’s mom gives 
him a photo album with suppos-
edly white pages, telling him that 

it was in his hands when they discovered him. 
Tom is confused, and when he opens the al-
bum, a photo with someone ressembling him 
very much in front of the house. As he looks at 
the other pages, he discovers that there was 
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someone called Amaury Blake that live here 
before, and that he befriended the Attic too. 
Thomas feels a little jealous about that, but 
he’s more surprised as Amaury could possi-
bly be his ancestor, considering their physi-
cal similarities and their same family name. 
He promises himself that he’ll look into that 
later, and vows to take revenge on the Attic for 
drinking his blood. 
When he finally recovers from his wounds sev-
eral days later, he decides to burn it. With his 
parents out for dinner, he prepares a torch and 
goes to the Attic, opens the door and throws the 
torch in. But it did not work. Instead of destroy-
ing it, he outraged the Attic. The whole house 
shakes, and Tom flees for his life, heading to 
Brynmor Hill. Just before he starts climbing 
it, he turns back and watches in horror as the 
Attic, which had now transformed itself into a 
huge golem of Darkness, was destroying the 
house, reducing it to particles of darkness. 

Crying because he lost his precious journal 
too, he continues to run until he reaches the 
other side of the Hill, into a small lake that 
reflected moonlight. Then he stops. He realizes 
that he doesn’t have any chance against the 
Attic and surrenders, surprised at how calm 
he was taking his own death. But it did not 
happen. Just as the black golem was climbing 
down the hill, the Mirror that Tom saw in the 
bathroom materialises before him and a huge 
ray of light emanates from it, and the Golem 
is instantly destroyed when the Light touches 
it. Instead of feeling happy and relieved, Tom 
feels strangely sad for having lost the Attic. 

The Mirror then tranforms itself into a Glass 
Woman, and she talks to Tom using Telepathy. 
She tells hims that she was actually a Mir-
ror from Dreamland that came to Earth, and 
that she was the Mirror assigned to Amaury 

Blake’s dream of the Attic, which came true as 
the Mirror was in the real world. 

The Glass Woman tells him that the sight of his 
blood changed the Attic, that it actually loved 
him before because he reminded him of its 
Creator, Amaury Blake. But it couldn’t resist 
its taste for blood and entered in a frenzy-like 
state, which incited it to drink Tom’s blood. 
She said that It was actually trying to protect 
him when It told Tom to get out. Thomas’ heart 
breaks when he hears this, and he feels guilty 
for all that happened. The Glass Lady also 
tells him that Amaury was killed in Dreamland 
during his visit by a servant of Light, which 
left the Attic devastated, then she goes back to 
Dreamland after allowing Thomas to keep the 
dark necklace as a souvenir.

I finished the story with an epilogue, and the 
moral I assigned to my story is that Light 
Is Not Always Good, and that Dark Is Not 
Always Bad, because the Attic, which was 
an evil entity, actually felt this great feeling 
called Love for a human being and that the 
fairy which was supposed to be good tried to 
commit that horrible sin called Murder. 

I don’t know what people think of it yet; I 
haven’t received any feedbacks, but I should 
get the results for the contest soon. So, that’s 
it. 

I’ve told you about the most important as-
pects of my short life, and hmm, if you want 
to know, my favourite authors are Stephen 
King, Karen Marie Moning, Stephenie Meyer, 
Stephen Law, Bernard Werber, J.K Rowling, 
and some more. My favourite books are Ma-
cabre (Stephen Law), Carrie (S. King), Harry 
Potter Series (J.K.R), House of Night Series 
(PC and Kristin Cast) and the Last Apprentice 
Series (Joseph Delaney). My favourite colours 
are Purple and Indigo, my favourite bands 
are Evanescence and The Cranberries and my 
favourite singers are Mylene Farmer, Najoua 
Belyzel and Ellie Goulding. 

And finally, I would like to remind you how 
lame were my entries on PXLEyes before, and 
that I still continued doing my best and I even-
tually improved. 

You should never underestimate yourself, 
you’re much more than you think you are. 

Have a nice day !

My study place, with all the books 
and stuff.
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Antwerp is an old and historic town in the heart of 
Belgium founded by the Romans. 

It’s artloving history is the perfect place to host  PXLs  
headquarters, an appartment on the 4th floor in the 

middle of this city’s historic centre.

PXL founder (MisterMonty) showed us around town and 
gave us a look at where PXL is made and maintained. 

We were joking about it for quite some time... to visit the Big Boss in Ant-
werp.
And in August it finally happened! Rob and I were in the Netherlands to 
visit my parents in law and because it is not far from the Netherlands to Bel-
gium, we decided to visit the Big Boss!

After a pretty adventures ride through Antwerp, we finally made it and met 
Frank, who was waiting for us in a small café. The guys talked about com-
puter stuff and I was busy to look at all the beautiful old buildings. 

http://www.pxleyes.com
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Antwerp is a very pretty and impressive city. Not at all how you would imagine a city of that 
size. The city center is full of old buildings with ivy hanging from one side to the other. Who 
needs Paris, if you can have Antwerp?

Shortly afterwards we started to walk to Franks residence. He lives pretty much in the center 
in a very lovely little apartment. I was a tiny bit enthusiastic! I mean, how often do you see the 
headquarter of PXL? I was allowed to sit in his chair and had the control over PXL for about 2 
minutes! He also showed us a bunch of all his secret pages and what he can all do with just one 
single click. I was impressed. 

We ate delicious kebab and started to explore 
the city a bit afterwards.

On one big square in the middle of the town 
was a small band playing “Hallelujah”, it was 
simply beautiful, especially because we were 
eating delicious Australian ice cream, while 
we were listening. 

It was a great day and we had a lot of fun!

http://www.pxleyes.com
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Golden Headed Owl
IDt8r

Light Balloons
Robart523

From Thought to Canvas
IDt8r
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Gold and Lace
CorneliaMladenova

Black Wind
Robart523

Amandine - The Parisian Doll 
CommanderBond

Future Toy
IDt8r
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Ready for my Closeup
MnMCarta

May I have this dance?
MnMCarta

H&S
maclu2iaf
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Sphingidae
Rik

Together
 mqtrf

Melancholic sound.
karaflazz

Forest flow
Pat
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Before we get too deeply involved in this, 
I’d like to explain that I am an extremely shy 
person with the social skills of a grapefruit, but 
I will do my best to make this article entertain-
ing for you. Although I’ve had an interesting 
life (interesting, as in “May you live in inter-
esting times.” kind of interesting), my path has 
leveled out somewhat and life is not quite so 
chaotic anymore.
So with that in mind...It all started in 1954, 
when I was born. Oh, you don’t want to go 
back quite that far? Understandable. I’ll skip 
ahead. I’m currently living in the USA, smack 
dab in the middle of Washington  state.

I moved here from Idaho with my husband, 
who is in retail and sells electronics, and my 
16 year old son, who just got his driver’s li-
cense...eek! My 34 year old daughter, who is a 
clerk  at the same store as my husband, joined 
us later. 

HOME STORY: IDT8R
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I’ll save you the trouble of doing the math. 
Yes, that’s an 18 year difference between 
kids. I wanted to raise just one child, so I did. 
Twice.

We live in a valley and one of my favorite 
sights, when we are returning home, is cresting 
the ridge outside of town and seeing this view. 

Day or night, it never fails to make me smile. 
As you can see, we’re an agricultural town. 
The fields are mostly feed crops of corn, al-
falfa and especially timothy hay. We also have 
a university here and when the students ar-
rive in September, the population can swell to 
twice its summer time residency. Before it was 
a university, it was the first “Normal school” in 
the state.  Yes, really. 

We put the fun 
in dysfunctional

A view of my valley home from the ridge

So, I have been tapped to talk about myself. On my list of least favorite things 
to do, this would be number 4, right before number 5, cleaning the litter box. 

But I’m a trooper, so I’ll give it a go. 
Hmmm. Let’s see. I’m a fat, goofy looking old lady with a somewhat quirky 

sense of humor. Turn ons: Food, photoshopping and long walks on the beach...
in the rain...by candle light. Turn offs: Big cities, washing dishes and mean 

people. I have a strong tendency to keep myself to myself, due to a chronic shy-
ness issue and most people misinterpret this as snobbery or snootiness, which 
is most unfortunate for me. (Is she whining? That sounds like whining to me.) 
My greatest pleasure in life is my family...and laughter. I’m quite lucky in that 

my family is very good at making me laugh. Sometimes intentionally. I have 
a rather high intelligence (OK, now she’s just bragging. She’s not really that 

smart.) which helps me sort out the different voices in my head.

http://www.pxleyes.com
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As explained to me, because I had to ask, of 
course, a normal school was the place students 
went to learn how to be teachers. Why was it 
called “normal”? I haven’t found an answer 
to that one yet. The university now does more 
than teach future teachers. They have all the 
courses offered at other universities, but I 
think my favorite is a course in chemistry. For 
their final exam, they make fireworks.   
Probably the most notable thing about my lit-
tle town is the wind. 35 mile an hour (56 kph) 
winds are not uncommon. Trees and plants all 
lean to the south and windbreaks are pretty 
popular here. With so much wind, the utilities 
have erected wind farms across the valley. 

Currently, there are three different wind farms, 
all adding to the electrical grid. These wind 
turbines are HUGH! One blade is 129 feet 
(39.3 meters) long. 

That’s 5’10” (1.7 meters) me standing at the 
base of the blade and my 6’1” (1.8 meters) 
husband at the tip. I don’t remember how tall 
they are, but if you look closely at the picture 
of the windmill, at its base you’ll see little, 
tiny dots. Those are people. 

Mt. Rainier from the wind farm

Look close and you’ll see the people

This is a damaged blade made into 
a display

Because we’re such a small town, there re-
ally isn’t much to do on a spontaneous basis. 
There’s  a movie theater, a library, bars, of 
course, and parks. So, if you want to do any-
thing outside of those things, you have to plan 
for it and it becomes an event. The local farm-
ers market is one of those events (seriously).

 

Local farmers and artists set up booths to 
display their wares, ranging from home grown 
fruits and veggies to jewelry, stone art, metal 
works,  porch swings and quilts, to name a 
few. Its a pleasant way to spend a Saturday 
morning and socialize with friends and neigh-
bors. Its also possible to wander around town 
and come upon artworks. Some are in obvious 
places, like the bull sitting on the bench, but 
some are more discrete, like the falling cat in 
the alleyway. 

Saturday’s farmers market, the 
place to be

Cat on an alley wall

This ain’t no bull

http://www.pxleyes.com
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In the summer its hiking, camping and fishing. In the 
winter, its skiing and snowmobiling. 

For those less inclined towards physical activity, a jaunt 
over the mountains will take us to Seattle. There’s lots 
to see and do there. Last year we went to a rock concert 
featuring Alice Cooper and Rob Zombie. I’d never been 
to a concert like that before. The spectacle was...mind 
boggling. I much prefer when we go to Seattle to watch 
the Mariners play a baseball game. 

The big event during the summer 
is Jazz in the Valley. Musicians 
from all over the state show up 
for this weekend of blues and 
jazz. They mostly play in venues, 
but there are roaming musicians 
and occasional outbursts of jam 
sessions. For one weekend in 
July, the downtown  area is filled 
with people and music. We didn’t 
go this year, so no pictures.
The last big local event is the 
rodeo and county fair at the be-
ginning of September. The fair 
includes carnival rides, a western 
village where they demonstrate 
what life was like a hundred 
years ago, the Yakima Nation 
Indian village with teepees, 
dancing and crafts and judging 
of local endeavors like pickles, 
quilts, photography, art, the big-
gest pumpkin, the best sheep, 
cow, chicken, duck, wool...any-
thing craft and country related. 
The rodeo has a parade through 
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Drift wood horse on the WSU campus

downtown, bull riding, barrel racing, a rodeo 
queen competition, rodeo clowns, bronc rid-
ing and a mutton buster competition for the 
kids. That’s when they plop a little kid on the 
back of a sheep and tell him or her to hang on 
before they let the sheep loose. I still haven’t 
figured out if its terror or determination that 
makes those 6 year olds stick to the sheep.
You don’t have to wander too far out of town 
to find something to do. Since we’re surround-
ed by mountains, outdoor activities are very 
popular.

Flooded mountain lake

Easy hike to a mountain stream

I’m just as happy to go home 
again. You know what they say...
You can take the girl out of the 
small town...and before long, 
she’s starting to freak out.

I’ve always been interested in 
what others around the world do 
in their everyday lives, so know-
ing that others outside the US 
will be reading this, I’ll share 
some of what we do as a typical 
normal  (ahem) as a family. Clos-
er to home, we all pretty much do 
our own thing. My husband plays 
Strat-o-matic, which is a game 
where you pretend to be the man-
ager of a pretend team of baseball 
players competing against other 
guys who also pretend to be man-
agers of pretend teams. 
I guess all this pretending can 
get pretty serious, but what do I 
know? Keeps him from under-
foot. 

My son plays video games where 
he pretends to be a cowboy or 
detective or an army guy kill-
ing aliens or a guitar hero. Like 
father, like son. Hmmm. 

My daughter has recently taken 
up photography and seems to 
have a pretty good eye for it. 
Most of the photos in this article 
were taken by her, as a matter of 
fact. 

And as for me, I do photoshop-
ping. When we do manage to 
regroup, we’ll watch TV, discuss 

Snoqualmie Falls is a good destination for a day trip

I guess he’s famous or something
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what’s going on in the world or 
play that silly guitar video game. 

Our latest endeavor is a pretty big one. We’re having a 
custom home built. It started out simple enough. Let’s 
buy a home. But then we saw a certain commercial 
advertising the ease and simplicity of having your own 
home built. How hard could it be? Its done every day. 
Fair warning, folks. Building your own home is much, 
much more complicated than just buying one that’s al-
ready built. 

But as aggravating as buying the lot, getting the plans 
approved, finding contractors, getting permits  and keep-
ing track of all the paperwork is, the end result will be 
well worth it. 
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80 81THE EYE magazine of www.pxleyes.com

VISIT IDT8R AT http://www.pxleyes.com/profile/IDt8r/

Sometimes we cook outside

Sometimes we cook inside

That’s my story and I’m sticking to it. 

So, there you have it. Its a pretty simple life we’ve got going on here, 
but that’s quite alright with me. Hope you enjoyed this little peek into 
my world and it didn’t put you to sleep. Or, if it did put you to sleep, I 
hope you had a nice nap.

Sometimes we don’t cook at all

From this empty lot to...

Home, sweet home

http://www.pxleyes.com
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I’m often asked how Photoshop is 
applied in my professional work or 
basically “How can I make some 
money with this stuff?” 

It’s true that Photoshop offers even 
non-artists the opportunity to create 
images once limited to the trained 
illustrator but if you really want to 
become a professional Photoshop 
artist I still recommend you study 
traditional art, even if you don’t 
have drawing skills the knowledge 
will aid your work in any draw-
ing program. Composition, layout, 
anatomy, technique, painting styles 
etc., are all most helpful to create 
better images. 

Photoshop is used in many areas of 
commercial art and advertising, for 
this article I’ll use a recent project 
as an example that was also a fun 
assignment for any artist. 

‘Horatio’ is his name and he represents the Hertz Car Rental 
company in their latest advertising campaign. 

The man behind this new icon is one of our own: Spaceranger! 

We asked Spaceranger to tell the story behind Horatio, ex-
plaining how an idea comes to life and to show the creative pro-
cess involved in the birth of a worldwide advertising campaign.

PHOTOSHOP IN THE PROFESSIONAL WORLD, HORATIO COMES TO LIFE WITH PHOTOSHOP
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I’m a professional artist trained in traditional art meth-
ods. Because of the increased use of computers in adver-
tising it became necessary to learn Photoshop. I never 
took classes in computer or Photoshop and learned ba-
sics from my friend and colleague Vic Spadoni who you 
may remember as Vicspa from the old PST (Photoshop 
Talent) days. Vic turned me on to PST as a great tool 
to learn…he was right! I owe a great deal to PST, now 
Pxleyes for providing a diverse learning experience and 
increasing my skills while having fun doing it.

Back in February 2011, Hertz, the well-known car rental 
company, wanted to create a mascot for their companies 
advertising. Iconic characters and mascots have been a 
main stay in advertising for a long time. Characters like 
Speedy Alka Seltzer, the Pillsbury Doughboy and the 
Michelin Man to give a few examples. 

Creating the right character is important to the product 
identity, the creation must be iconic and be readily iden-
tifiable with the company. Doyle Dane Bernbach (DDB) 
was the New York based Ad Agency who searched for 
an artist to help with the project. Having seen samples of 
my work, which included some of my contest entries, I 
was chosen for the assignment. 

Horatio and all images of this character are copyrighted 
and the trademark of the Hertz Corporation

Some of the contest entries shown to the client that 
influenced their choice of artist.

http://www.pxleyes.com
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The work begins with a conference call with the art director and the art buyer from DDB. We 
discuss the particulars about the character and the use in various formats. 
The client provided rough sketches of some concepts then talked about mixing and matching 
different ideas, this meant there would be at least a dozen versions to create. Throughout the 
project we would confer about what changes should be made and in all it was the exchange of 
ideas that lead to the final result. 
Every aspect was discussed, the head shape, the body shape, the proportions, the pose and the 
expression. Because I was working in Photoshop I could render each of the elements separately 
and put them on layers. This way I could simply turn off one layer and turn on another while 
the rest of the image remained the same. I could provide the client with a jpeg of each version 
without having to redraw the character. 

The “wink” was the next issue, one eye… both eyes… eyeballs… open mouth… teeth? Ulti-
mately a simple one-eye wink was the choice with a closed mouth smile. 

The first major change was in the head to body 
proportion, at first we weren’t sure if we would 
go with a more realistic ratio like the Michelin 
Man but it was soon decided to go with a big 
head smaller body and so the project became 
known as the “Bobble Head Project”.

The little fellow was named Horatio after a 
physician, Horatio Nelson Jackson who was 
one of the first people to drive a car across the 
United States. 

Initial client Photoshop sketches.

Additional client sketches for 
bobble head version.

Horatio Nelson Jackson

PHOTOSHOP IN THE PROFESSIONAL WORLD, HORATIO COMES TO LIFE WITH PHOTOSHOP
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Now variations of the big head were needed, the body pose and proportions were established so 
next I had to create three positions of the character in front, side and rear views. The three body 
poses became my second layer with a black to white simple gradient for the background. I next 
created each head style for each pose and placed them on several layers over the bodies. 

Once complete I would make a jpeg of each version to provide to the client for final approval 
and selection. The creative group at DDB met in conference and the final version was selected. 

My last task was to provide the client with a PSD of 
the final version and a high res jpeg. The presentation 

by DDB was successful, Hertz loved the Horatio char-
acter we created and the campaign was under way. 

The CS4 Photoshop work was really pretty basic. I used basic shapes and warped them to suit. 
A good deal of hand drawing was done using the brush tool with a Wacom Intuos 4 tablet. 
Control is very good and only a little touch up was needed. A base layer for each shape was cre-
ated in yellow and all shading was done on layers placed above. This allowed individual adjust-
ments to be made to highlights, shadows and fill color. This was done for each head and body as 
a separate group. 

Alternate versions of smiles, winks etc. each had their own light and shade linked to them in 
groups so I could turn each one on or off completely. Shading was done on multiplied layers 
with a soft brush on low opacity. Highlights were created with a soft brush also on low opacity 
and placed on a normal layer.

I’ve included some examples of the work as well as a couple of links about the Horatio charac-
ter. I do hope you’ve found this of interest, it’s not often that an artist’s creation gets high vis-
ibility, most of a commercial artist’s work is seen only by those in the industry but even so it’s a 
rewarding career for a creative individual and Photoshop is an essential tool for the artist today.

Horatio and all images of this character are copyrighted 
and the trademark of the Hertz Corporation

Some of the many versions created.

The final approved version.

Frame grabs from TV spots and press release 
3D test version.

Links:
Hertz commercial on www.youtube.com

New York Times press release

PHOTOSHOP IN THE PROFESSIONAL WORLD, HORATIO COMES TO LIFE WITH PHOTOSHOP

Written by: Spaceranger (Rein)
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NASIR: How did you find pxleyes and 
what do like most about it? 

KELLIE: I have a bad memory so I actually 
couldn’t remember for a while how I found 
pxleyes, but I believe that I found it looking 
for photoshop contests. What I like best about 
pxleyes is that people help you out, most are 
constructive about their criticism and you get 
a sense of acceptance from someone on here, 
even if your work is terrible! I’ve even met 
REAL people online from here. 

NASIR: I have seen your entries in 
photoshop, drawing, 3d and photogra-
phy. Which is your favorite and why? 

KELLIE: I would have to say that my fa-
vorite of all the contests would be photogra-
phy. When I was younger, I entered paintings 
into 4-H fairs and won first, second and third 
places, but as an adult I think I have lost some-
thing...maybe my imagination or ability to 
release my inhibitions. This leads me to pho-
toshop; I have the tools and know how to use 
them, but I hit a road block right away because 
I lack the imagination like others have here. I 
dabbled a bit in 3D only because I had an easy 
program to try out- Bryce 3D. It is a wonder-
ful program, but it is somewhat limited. I don’t 
believe I have the patience for regular 3D 
programs. Photography is something I liked 
as a child and still as an adult. I had dozens 
of rolls of film at 10 years old that sat, need-
ing to be developed; some developed 20 years 
later! When I picked up a professional camera 
while doing school pictures though, I knew the 
possibilities were endless with what I could 
do. Photography, plus the photoshop tools 
equalled great pictures. It seems some of my 

NASIR: Tell us something about yourself. 

KELLIE: I am a mom of 3 kids and wife of 1 big kid. I 
have a 22 year old step-son, a 19 year old daughter, a 15 
year old son, and a 42 year old husband. I worked from 
the time I was 12 until about a year ago. For a few years 
I took school pictures, until I had no more patience for 
the teenagers that parents seemed to have forgotten to 
teach respect to, and I now have ventured off learning 
photography by myself (and with help of others on px-
leyes). My life is an open book if you ask me, but there 
is a lot of things to tell because I have experienced a lot 
in my life.
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best photographs though either do not fit in 
any category, or I have put them in the wrong 
category to do well in.
It is okay though because I have sold some of 
those great photographs in an art gallery, so I 
know I must be doing
something right.

VISIT K5683 AT www.pxleyes.com/profile/k5683
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NASIR: How would you describe your 
style of work in photography? 

KELLIE: My style of work in photogra-
phy all has to do with where I am, what type 
of atmosphere I am in with a certain type of 
people, or how hard I want to work to get a 
particular type of picture. It seems I do best 
in natural outdoor photography though. Flash 
photography is something I need to work on, 
which leads me to the next question...

NASIR: Did you go to school to study 
photography? 

KELLIE: I did not go to school for pho-
tography. I learned some posing techniques 
and group pictures while I did the school 
pictures, but all the lighting was done for us 
with guides. I would love to take classes to the 
learn the basics of photography, mainly light-
ing. I have received some help from Adam and 
Steve (Locksmagic and Magicsteve) while on 
an abandoned building and star trail expedi-
tion.

NASIR: How do you find your subjects 
for photography? 

KELLIE: My subjects are mainly out in the 
nature. The few actual subjects being people, 
were my family or friends. It is easy to find 
subjects who are very willing to pose for pho-
tography; all you have to do is ask. I used to 
model for a photographer named Sean McI-
ntyre who politely asked me if I ever thought 
about modeling. I don’t think you need to ask 
a beautiful weed that may be sitting all alone 
on the side of a river bank at sunset though.

NASIR: What kind of equipments you 
use for shooting? 

KELLIE: I used to have an 8 Megapixel 
point and shoot straight shooting camera that 
I actually got some real good shots on (and 
scored high at pxleyes) but now I mainly use 
a Nikon D80 that I bought used from ebay. I 
have a flash that I bought from Meijer for $70 
but it is not as powerful as the $300 flash I 
would like to buy. I have simple cheap equip-
ment I buy from ebay like rain gear, filters for 
the lenses, shutter release cords, flash brack-
ets.....all which I rarely use. Cheap point and 
shoot cameras really are adequate though for 
most natural artistic shots.
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NASIR: Do you have any advice and 
tips for beginners, who are interested in 

learning photography? 

KELLIE: Experiment & experience is what 
will get you going! Oh, and NOT being a pro-
crastinator like I can be at times. Just do it!

NASIR: Who inspires you on and 
off pxleyes? 

KELLIE: I wasn’t going to answer this 
question because I didn’t want to offend
anyone, but I will try my best to explain 
this. To me, “inspire” also involves “mo-
tivating”. I love the work of others here, 
but none of them motivate me to do bet-
ter work because I don’t see any of them 
on a daily basis. I would have to say that 
my friends, family and the company I 
volunteer for (Do-All Inc.) inspire me 
the most.

NASIR: Do you want to see some 
more features to be added to pxl-

eyes? 

KELLIE: In all honesty, I like pxleyes 
the way it is and hope nothing changes 
for a long time. I know Mr. Monty prob-
ably wants to stay modern and with the 
times and also wants to please all the 
members here, but things are great here 
as they are so why change something 
that isn’t broken? Look at how many 
people get used to sites like Facebook 
and get upset when it changes.

NASIR: Are you using photoshop 
for your entries. If so, then what is 

your favorite tool and plugin? 

KELLIE: Yes, I use a like-photoshop 
program (paint shop pro 7) for my en-
tries. I usually make a basic adjustment 
with curves, levels or saturation with 
most of my entries. I try to keep it as 

close as possible, per pxleyes guidelines. At 
times I go a little further and use some layer-
ing modes, but always use any adjustments to 
the picture as a whole since the photography 
contests are stricter on the rules. Even the art I 
sell offline is as much like the original as pos-
sible because I want the viewer to see what I 
saw in all of its beauty.

NASIR: What are the biggest personal 
or professional challenges you face on 

a daily basis? 

KELLIE: Procrastination would have to 
be the ultimate challenge for me personally 
and professionally. Believe it or not, I have a 
slight case of bi-polar, but I hate to use it as 
an excuse for anything. It holds me back from 
certain things professionally, but mainly I am 
limited professionally by my shyness and lack 
of confidence to be able to get out there and 
advertise my abilities.

Thank you for the opportunity to be inter-
viewed for pxleyes.

VISIT K5683 AT www.pxleyes.com/profile/k5683

http://www.pxleyes.com
http://www.pxleyes.com/profile/k5683


Text example

DRAWING: BEST OF JULY, AUGUST & SEPTEMBER 2011
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Long John Silver
Hayato

The Big Rain
Glockman

lady aries
yahidithmonnalisa
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Text example
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Rainy day
roon

Do I look Funny ?
Glockman

The 0strich Lady 
Glockman

The Pirate Boy
Hayato
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Text example
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wild animal eyes
Momof4boyoboys

it flies..it flies!!!
roon

The Migration
Robart523

june
 tk
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Text example
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Chop
mircea

On Track
Missy

Croc
mircea
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Text example
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Escher’ Impossible Cube
mircea

Spitfire
mircea

Wood 
farsite

more pencil and paper
dante

http://www.pxleyes.com


Mister January likes to take things 
easy. He likes to eat his meat in the 

shape of peperoni sausages. 

Favorite bodywear:
whatever he decides to eat
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Mister April is the intellectual type, he thinks before 
he acts and therefor needs a little more time.  This ex 
soldier compensates his bald head with a furry rug at 

another other part of his body.

Favorite bodywear:
bright white socks of the brand Dickies
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Mister July loves fresh air and  long romantic 
walks in the moonlight. This former magician 

loves to surprise his dates in unusual ways.

Favorite bodywear:
light colored raincoat made by LL BeanPX
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Mister October is more a down to 
earth type who likes fires and playing 

with his fire hose. Nevertheless he 
likes to stand in the limelight. 

Favorite bodywear:
his watch made by Body Glove
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